XVR Fast Operation User Manual V3.1

Welcome

Thank you for purchasing our XVR!
This manual is designed to be a reference tool for the installation and operation of

your system. Here you can find information about this series XVR features and
functions, as well as a detailed menu tree. Before installation and operation please

read the following safeguards and warnings carefully!

Important Safeguards and Warnings

Do not place heavy objects on the XVR.
Do not let any solid or liquid fall into or infiltrate the XVR.

Please brush printed circuit boards, connectors, fans, machine box and so on
regularly. Before the dust cleaning please switch off the power supply and unplug it.
Do not disassemble or repair the XVR by yourself. Do not replace the components by

yourself.

Environment

Please place and use the XVR between 0°C and 40°C.Avoid direct sunlight. Stay
away from heat source.

Do not install the XVR in damp environment.

Do not use the XVR in smoky or dusty environment.

Avoid collision or strong fall.

Please insure the XVR level installation in a stable workplace.

Please install in ventilated place. Keep the vent clean. Use within the rating input and

output scope.

F_ﬂ XVR refers to the device may be DVR, HVR, NVR, SVR.



Overview

IMPORTANT SAFETY INSTRUCTIONS

Read these operating instructions carefully before using the unit.
Follow all the safety instructions listed below.
Keep these operating instructions handy for future reference.

(1) Read these instructions.

(2) Keep these instructions.

(3) Heed all warnings.

(4) Follow all instructions.

(5) Do not use this apparatus near water.

(6) Clean only with dry cloth.

(7) Do not block any ventilation openings, Install in accordance with the
manufacturer’s instructions.

(8) Do not install near any heat sources such as radiators, heat registers,
stoves, or other apparatus (including amplifiers) that produce heat.

(9) Do not defeat the safety purpose of the polarized or grounding- type plug.
A polarized plug has two blades with one wider than the other. A grounding
type plug has two blades and a third grounding prong. The wide blade or
the third prong is provided for your safety. if the provided plug does not fit
into your outlet, consult an electrician for replacement of the obsolete
utlete.

(10) Protect the power cord from being walked on or pinched particularly at
plugs, convenience receptacles, and the point where they exit from the
apparatus.

(11) Only use attachments/accessories specified by the manufacturer.

(12) Use only with the cart, stand, tripod, bracket, or table specified by the
manufacturer, or sold with the apparatus. When a cart is used, use
caution when moving the cart/apparatus combination to avoid injury from
tip-over.

(13) Unplug this apparatus during lightning storms or when unused for long
periods of time.

(14) Refer all servicing to qualified service personnel. Servicing is required



when the apparatus has been damaged in any way, such as power-supply
cord or plug is damaged, liquid has been spilled or objects have fallen into
the apparatus, the apparatus has been exposed to rain or moisture, does
not operate normally, or has been dropped.

BEFORE START

This manual provides operational information necessary for using the
product and contains a description about each component part and its
function as well as menu or network settings.

You have to keep in mind the following notices:

We are not liable for any or all losses to the product incurred by your use of
non-standard product or violation of instructions mentioned in this manual.
Prior to opening the case, please consult a qualified technician first.
Whenever this is needed power must be removed from the unit.

Before installing additional HDD or connecting the SATA device to this
product, check if it is compatible with the product.

WARNING

Battery

It is essential that when changing the battery in the unit, the replacement
battery must be of the same type otherwise there may be a possibility of an
explosion. The following are the specifications of the battery you are using
now.

Normal voltage : 3V

Normal capacity : 220mAh

Discharge Current : 0.2mA

Operating temperature : -20°C ~ +85°C (-4°F ~ +185°F)

Caution

Connect the power cord into a grounded outlet.
The Mains plug is used as a disconnect device and shall stay readily
operable at any time.

Batteries shall not be exposed to excessive heat such as sunshine, fire or
the like.

Risk of Explosion if Battery is replaced by an Incorrect Type. Dispose of
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Used Batteries According to the Instructions.

System Shutdown

Turning off the power while the product is in operation, or undertaking
improper actions may cause damage or malfunction to the hard drive or
the product.

To safely cut off power, press the front Power button on the product to
display the confirmation message. Click <OK> and then unplug the power
cable.

You may want to install a UPS system for safe operation in order to prevent
damage caused by an unexpected power stoppage. (Any questions
concerning UPS, consult your UPS retailer.)

Operating Temperature

The guaranteed operating temperature range of this product is 0°C ~ 40°C
(32°F ~ 104°F)

This product may not work properly if you run right after a long period of
storage at a temperature below the guaranteed one.

Prior to using a device that has been stored for a long period in low
temperatures, allow the product to stand at room temperature for a period.
Especially for the built-in HDD in the product, its guaranteed temperature
range is 5°C ~ 55°C (41°F ~ 131°F)

Likewise, the hard drive may not work at a temperature below the
guaranteed one.

Ethernet Port

This equipment is in door use and all the communication wirings are limited
to inside of the building.

Security Precautions

The default password can be exposed to a hacking thread so it is
recommended to change the password after installing the product.

Set password for your wireless network if you use the product with a
wireless router.

Being not protected with password or using the default wireless router
password may expose your video data to potential threat.

Note that the security and other related issues caused by the unchanged
password shall be responsible for the user.
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FEATURES

The product compresses camera inputs from 4/8/16/24/32 channels with
H.264 video codec, and supports simultaneous recording and playback
of 8/16-channel audio input to/from HDD. These XVR also supports
network connectivity, providing remote monitoring from a remote PC
transferring video and audio data.

Provides a convenient User Interface 4/8/16/24/32 CH Composite Input
Connectors

Supports CIF(S)/2CIF(M)/ACIF(L)/WD1 recording formats

With the network specific codec, network transfer enabled regardless of
the recording conditions

Display of HDD information and status by using HDD SMART

HDD overwrite function

Mass storage HDD backup through high-speed USB 2.0

Simultaneous Record and Playback of 8/16-channel video data
Various Search Modes (Time, Event, Backup, Pos, Motion Detection)
Various Recording Modes (Manual, Event, Scheduled Recording)
Alarm Interface

Remote Monitoring function by Network Viewer, Smart Viewer and Mobile
Viewer

Supports coaxial protocols

Tampering Detection

PACKAGE CONTENTS

Please unwrap the product, and place the product on a flat place or in
the place to be installed.

Please check the following contents are included in addition to the
main unit.
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PART NAMES AND FUNCTIONS (FRONT)

Our XVR has multiple series, different series have different front and rear
panel, and even the same family also may be different.
The following uses the F-Series front as an example to illustrate.

num Button Part Names Functions
1 Power Press to perform_startup,
shutdown operation.
2 2 USB interface External USB storage device,
mouse, burner, and so on.
3 Jog foreign key Real-.t|me I’.TIOI’]I.'[OI‘Ing when left
and right direction keys.
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Speed down

Video file playback, a variety of
slow speed, and normal
playback.

Speed up

Video file playback, a variety of
fast speed, and normal
playback.

Rewind / pause

Forward playback or playback
pause, press the button
backward playback.

Backward playback, press this
button to pause playback.

Play / Pause

Press the button forward
playback.

Pause playback.

Pause resume playback

In real-time monitoring status,
press this key to directly enter
video search menu.

Last video

Play the video before current
video

Next video

Play the video next

10

Numeric keys

Input Digital Channel
switching

11

Arrow keys

The current activated control
switch, can be moved up or
down

Change the settings, change in
number

12

Indicator

Show the system current
status

PART NAMES AND FUNCTIONS (REAR)

The following uses the F-Series rear panel as an example to illustrate.




Part Names

Functions

ATX power interface

Fan outlet

16 channel loop out

VGA video out

SDI Video out

Ethernet interface

1 USB interface

16 Alarm in / 16 Alarm out

1 Audio out

2 BNC video out

RIB|o|o|~o|u|s|w -

16 channel video in

=
N

16 channel Audio in

REMOTE CONTROL

q
i




Using the Numeric Buttons

Serial

Name Function
number

1 Multi-window button _Same function as Multi-window button
in the front panel

> Numeric button Co_de input/number input/channel
switch

3 <Esc> Same function as<Esc>button in the
front panel

4 Direction button Same function as direction button in
the front panel

5 Record control Control the record

6 Record mode Same function as “Record mode”

7 ADD Input the number of XVR to control it

8 FN Assistant function

Changing the Remote Control ID

1. Press the <ID> button of the remote control and check the ID displayed on
the XVR screen. The factory default ID of the remote control is 00.
2. Enter 2 digits of your selection in order, while pressing the system <ID>

button.

3. When ID input is done, press the system <ID> button again to check the

setting.




CONNECTING EXTERAL DEVICES

SPOTH HOME

VIDED OUT
LEY

VIDED IN

Connecting the USB

(1) by factory default, a USB port is provided for external connection.

(2) you can connect a USB HDD, USB CD/DVD player, USB memory or
mouse to the USB port.

(3) If a USB HDD is connected to the system, recognition and settings are
available in “Main Menu” “Device” “Storage Device”.

(4) the product supports hot plugging function that enables
connecting/disconnecting USB devices while in operating the system.

Connecting External SATA HDD

External SATA port is provided on the rear panel.
If connected to the system, the external SATA HDD can be recognized and
configured in “Main Menu” “Device” “Storage Device”.

Connecting the Alarm Input/output

The Alarm In/Out port at the back is composed of the following.
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Sensors

ALARMIN 1 ~ 8 : Alarm Input Port.

ALARM RESET: On receiving an Alarm Reset signal, the system cancels
the current Alarm Input and resumes sensing.

ALARM OUT 1 ~ 4 : Alarm Output Port.

Connecting the RS-485 Device

Connect the <TX/RX +, —> device through the back port.

Connecting the Network

(1) Connecting to Network through Ethernet




(2) Connecting to the Network using the router
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1 Production Introduction

1.1 Product Overview

The series XVR is designed especially for security and defense field which is
an outstanding digital surveillance product. It introduces embedded LINUX
operating system which is more stable. It introduces standard H.264mp video
compressed format and G.711A audio compressed format which insures the
high quality image, low error coding ratio and single frame playing. It
introduces TCP/IP network technology which achieves the strong network
communication ability and telecommunication ability.

The series XVR can be used individually or online applied as a part of a safety
surveillance network. With the professional network video surveillance
software it achieves the strong network communication ability and
telecommunication ability.

The series XVR can be applied in the bank, telecom, electric power system,
judicial system, transportation, intelligent housing, factory, storehouse, water
conservancy and so on.

1.2 Main Functions

Real-time Surveillance
Analog interface and VGA interface (VGA interface is equipped
selectively).
Surveillance function through monitor or display.

Storage
Non-working hard disk dormancy processing which is convenient to radiate
heat, reduce power and extend the life-span.
Special storage format which insures the data safety.

Compression
Real-time compression by individual hard disk which insures the audio and
video signal stable synchronization.



Backup
Through SATA interface and USB interface such as USB equipment,

removable hard disk and so on through net download the files in the hard
disk.

Playback
Individual real-time video recording as well as searching, playback,

network surveillance, recording check, downloading and so on.
Multi-playback mode.
Zoom at arbitrary region.

Net Operating
Through net tele-surveillance in the real time.

Tele-PTZ control.
Tele-recording check and real-time playback.

Alarm Linkage
Multi-route relay alarm output which is convenient for the alarm linkage

and light control at the spot protecting circuits at the alarm input and output
interface which protects the main machine from damage.

Communication Interface
RS485 interface which fulfills the alarm input and PTZ control.

Standard Ethernet network interface which fulfills the telecommuting
function.

Intelligent Operating
Mouse action function.

Fast copy and paste operating for the same setting.



2 Open-package Check and Cable

Connections

2.1 Open-package Check

When you receive the XVR, please check first .First; please check whether

there is any visible damage to the package appearance. The protective
materials used for the package of the XVR can protect most accidental
clashes during transportation. Then, please open the box and get rid of the
plastic protective materials. Check whether there is any visible damage to the
XVR appearance. At last, please open the machine crust and check the data
wire in the front panel, power wire, the connection between the fan power and

the main board.

Front Panel and Rear Panel

The key function specification in the front panel and the interface
specification in the real panel are in the specification.
Please check the product type in the front panel whether is accordant with

the product type you order.

The label in the real panel is very important for the after service
m Pleas protect it carefully When you contact us for after service

please provided the product type and serial number in the label



2.2 Hard Disk Installation

For the first use, please install the hard disk.

ldisassemble the screw @disassemble the cover  ®fix the screw of hard disk

[
\
L
3 4

l

@fix the screw of hard disk ®connect the data wire ®connect the power wire

2.3 Audio and Video Input and Output Connections

2.3.1 Video Input Connections

The video input port is BNC connector plug. The demand of input signal is
PAL/NTSC BNC (1.0VP-P, 75Q)

The video signal must be accorded with the state standard which has the
high signal to noise ratio, low aberration and low interference. The image
must be clear and has natural color in the appropriate brightness.

Insure the vidicon signal stable and credible

The vidicon should be installed in the appropriate location where is away
from backlighting and low illumination or adopts the better backlighting and
low illumination compensation.

The ground and power supply of the vidicon and the XVR should be
shared and stable.

Insure the transmission line stable and credible

The video transmission line should adopt high quality coaxial pair which is
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chosen by the transmission distance. If the transmission distance is too far,
it should adopt shielded twisted pair, video compensation equipment and
transmit by fiber to insure the signal quality.

The video signal line should be away from the electromagnetic
Interference and other equipment signal lines. The high voltage current
should be avoided especially.

Insure the connection stable and credible

The signal and shield lines should be firm and connected credible which
avoid false and joint welding and oxidation.

2.3.2 Video Output Connections and Options

The video output is divided into PAL/NTSC BNC (1.0VP-P, 75Q) and VGA
output (selective configuration)When replace the monitor by the computer
display, there are some issues to notice.

(1) Do not stay in the turn-on state for a long time.

(2) Keep the computer display normal working by demagnetizing regularly.
(3) Stay away from the electromagnetic Interference.

TV is not a credible replacement as a video output. It demands reducing the
use time and control the power supply and the interference introduced by the
nearby equipment strictly. The creep age of low quality TV can lead to the
damage of other equipment.

2.3.3 Audio Signal Input

(1) Audio port is BNC connection.

(2) The input impedance is high so the tone arm must be active.

(3) The audio signal line should be firm and away from the electro magnetic
Interference and connected credible which avoid false and joint welding
and oxidation. The high voltage current should be avoided especially.

2.3.4 Audio Signal Output

Commonly the output parameter of XVR audio signal is greater than 200mv
1KQ (BNC) which can connect the low impedance earphone and active sound
box or other audio output equipment through power amplifier. If the sound box
and the tone arm cannot be isolated, howling phenomena is often existed.
There are some methods to deal with the above phenomena.
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(1) Adopt better directional tone arm.

(2) Adjust the sound box volume to be under the threshold that produces the
howling phenomena.

(3) Use fitment materials that absorb the sound to reduce reflection of the
sound.

(4) Adjust the layout of the sound box and the tone arm.

2.4 Alarm Input and Output Connections

(1) Alarm Input

A. Alarm input is grounding alarm input.

B. Alarm input demand is the grounding voltage signal.

C. When the alarm is connected with two XVR or connected with XVR and
other equipment, it should be isolated by relay.

(2) Alarm Output

Alarm output cannot be connected with high-power load(no more thanl1A)
When forming the output loop it must prevent the big current from relay
damage. Use the contact isolator when there is a high-power load

(3) PTZ Decoder Connections

A. The grounding of the PTZ decoder and XVR must be shared otherwise
the common-mode voltage will lead to the PTZ control failure. The
shielded twisted pair is recommended.

B. Avoid the entrance of high voltage. Make the layout reasonably. Take
precaution from the thunder.

C. In the outlying end connect 120Q resistance paralleled to reduce the
inflection and insure the signal quality.

D. the 485 AB lines of XVR cannot connected with other 485 output
equipment paralleled.

E. The voltage between the AB lines of the decoder must be less than 5V.

(4) Front e Equipment g Grounding Note

Bad grounding can lead to the burnout of the chip.

(5) Alarm Input Type Unlimited

The XVR alarm output port is constant opening type.



(1) £2)(3) (4)

(1) Alarm input.  (2) Grounding.  (3) RS232. (4) alarm output.  (5) RS485

2.4.1 Alarm Input Port Specification

1 channel alarm input. Alarm input type unlimited. The grounding and the com
port of the alarm sensor are parallel (The alarm sensor is external power
supply)
The grounding of the alarm and the XVR should be shared.
The NC port of the alarm sensor must be connected with the XVR alarm
input port.
The grounding of the power supply and the alarm sensor must be shared
when used in external power supply.

2.4.2 Alarm Output Port Specification

1 channel alarm output. There is external power supply when using the
external alarm equipment. Please refer to the relay relevant parameters to
avoid the overload that damages main machine.

2.5 Speed Dome Connections

5 6T & T CNO

HiY485

12 34 +R a8

ARSAAANS

|
EEEEme
[.1.1.1.1] -

ALARM Dt
(1) Connect the 485 lines of the speed dome with the XVR 485 interface.

(2) Connect the video line with the XVR video input.
(3) Electrify the speed dome.




3 Basic Operation

&

The button in gray display indicates nonsupport.

3.1 Turn On

Plug the power supply and turn on the power supply switch. Power supply
indicator light shining indicates turning on the video recorder. After the startup
you will hear a beep. The default setting of video output is multiple-window
output mode. If the startup time is within the video setting time, the timing
video recording function will start up automatically. Then the video indicator
light of corresponding channel is shining and the XVR is working normally.
1. Make sure that the input voltage corresponds with the switch of the XVR
power supply.
2. Power supply demands: 220V+10% /50Hz.
Suggest using the UPS to protect the power supply under allowable
conditions.

3.2 Turn Off

There are two methods to turn off the XVR. Entering <Main Menu> and
choosing <Turn Off> in the <Turn off the system> option is called soft switch.
Pressing the power supply switch is called hard switch. Illumination:

(1) Auto resume after power failure.
If the XVR is shut down abnormally, it can automatically backup video and
resume previous working status after power failure.

(2) Replace the hard disk
Before replacing the hard disk, the power supply switch in the real panel
must be turned off.

(3) Replace the battery .

Before replacing the battery, the setting information must be saved and the
power supply switch in the real panel must be turned off. The XVR uses button
battery. The system time must be checked regularly. If the time is not correct
you must replace the battery, we recommend replacing the battery every year
and using the same battery type.



@ The setting information must be saved before replacing the
battery otherwise information will lose.

3.3 System Login

When the XVR boots up, the user must login and the system provides the
corresponding functions with the user purview. There are three user settings.
The names are admin, guest and default and these names have no password.
Admin is the super user purview; guest and default's permissions are preview
and video playback. User admin and guest’s password can be revised, while
their permissions can’t be revised; user default is the default login user whose
permission can be revised but not its password.

S¥STEM LOGIN

User Name |admin

Password

Please Login

Figure 3.1 System Login

Password protection: If the password is continuous wrong three
'{, times, the alarm will start. If the password is continuous wrong five
d times, the account will be locked. (Through reboot or after half an

hour, the account will be unlocked automatically) For your

system security, please modify your password after first login.

3.4 Preview

You can right click mouse to choose the switch between the windows.
The system date, time and channel name are shown in each viewing window.
The surveillance video and the alarm status are shown in each window.



Table 3.1 Preview icon

1 Recording status 3 Video loss

2 Motion detect 4 Camera lock

3.5 Desktop Shortcut Menu

In preview mode you can right click mouse to get a desktop shortcut menu.
The menu includes: Main Menu, Record Mode, PlayBack, PTZ Control,

High Speed PTZ, Alarm Output, Color Setting, Output Adjust, Logout,
View1/4/8/9/16 screens.

B Main Menu

% Record Mode
= PlayBack

™ PTZ Control
@ HighSpeedPTZ
€ Alarm output
:2: Color Setting

¥ output Adjust
& Logout

O view 1

Hview 4

B view 8

B view 9

B view 16

Figure 3.2 Shortcut Menu
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3.5.1 Main Menu

When you login, the system main menu is shown as below.

= Main Menu &

Record

: e
= |

Advanced

Figure 3.3 Main Menu

3.5.2 Playback

There are two methods for you to play the video files in the hard disk.
(1) In the desktop shortcut menu.
(2) <Main menu> <Record> <Playback>

Fﬂ

The hard disk that saves the video files must be set as
read-write or read-only state. (4.5.1)

11



Figre .4 vie playback

1. Listed files 2. File information. 3. File searching
4. File backup 5. Operation hint 6. Playback control

<Listed files> Look up the listed files that accord with the searching criteria.
<File information> Look up the found file information.

<File backup> Backup the chosen file. Click the button and operate as
followed.

i/
The storage must be installed before the file backup. If the
backup is terminated, the already backup can playback
individually.

12



; 'ﬁ PlayBack—=Backup " E

IC] Hame( Ty pe) Remain/Tolal " Detect |

{E] Deviuse DISK) L) GB/LOO OB
] peviine DvDRW) L0 GB/LOO GB Backup

Erase

S'h:r]'_l |

Cancel _'

Figure 3.5 detect the storage

<Detect> Detect the storage connected with the XVR such as hard disk or
universal disk.

<Erasure> Choose the file to delete and click erasure to delete the file.

<Stop> Stop the backup.

<Backup> Click backup button and the dialog box is popped up. You can
choose the backup file according to the type, channel and time.

Main Menu->=Record sRackup>=RBackup

Fype e

Chunnel i1 |
Start Time B8 12010 - 08 - Jih | |' Remove
|

End Time B ::uu:- a}.} 19 15 |T—

[ |Channe Lengih

Required/Remaining:0.00 KB/LOO OB

Figure 3.6 recording backup
13



<Remove> Clear the file information.

<Add> Show the file information satisfying the set file attributes.

<Start/Pause> Click the play button to start the backup and click the pause

button to stop the backup.

<Cancel> During backup you can exit the page layout to carry out other

functions.

<File searching> Search the file according to the searching parameter.

search Condition

File Type |All [{™] |Read/Wrile i

hannel n. ...u.‘ L

Start Time | 2al0 0F - 01 |0oD; 00 0D

End Time |2032 il of |00 00 0D

Figure 3.7 file searching
<File type> Set the searching file type.
<Channel> Set the searching channel.

<Start Time> Set the searching time scan.

[ tanecel

<Playback Control> Refer to the following sheet for more information.

Table 3.2 Playback control key

Button Function Button Function
/ Play/pause Backward
Stop Slow play
Fast play Previous frame
Next frame Previous file

14




Next file Circulation

Full screen

Frame by frame playback is only performed in the pause playback state.
<Operation hint> Display the function of the cursor place.

Special functions:
<Accurate playback> Input time (h/m/s) in the time column and then click
play button. The system can operate accurate
playback according to the searching time.

<Local zoom>  When the system is in single-window full-screen playback
mode, you can drag your mouse in the screen to select a
section and then left click mouse to realize local zoom. You
can right click mouse to exit.

3.5.3 Record Mode

Please check current channel status: “o” means it is not in recording status,
“e” means it is in recording status. You can use desktop shortcut menu or click
<Main menu> <recording function> <recording set> to enter the

recording control interface.
Record Mode
Schedule ol KR R N E N EE N N ENNE NN
hiam il ! { 0 y

] Cuncel

Record Mode All 1 2 3 4 5 a4 7 8 9 10 11 12 I3 14 15 16

Figure 3.8 ~ Figure 3.8 Record Mode =
<Schedule> Record according to the configuration.

<Manual> Click the all button and the according channel is recording no
matter the channel in any state.

<Stop> Click the stop button and the according channel stops recording no

matter the channel in any state.
15




3.5.4 Alarm Output

Please check current channel status: " means it is not in alarming status, “e”
means it is in alarming status. You can use desktop shortcut menu or click
<Main Menu> <Alarm Function> <Alarm Output> to enter the alarm
output interface.

“AE Alarm Output

Configuration
Manual
_‘;ri-['!

Status

Alatm Type A

- oK - [ Cancel

Figure 3.9 Alarm Output
<Configuration> Alarm is on according to the configuration.

<Manual> Click the all button and the according channel is alarming no matter
the channel in any state.

<Stop> Click the stop button and the according channel stops alarming no
matter the channel in any state.

3.5.5 PTZ Control

Operation interface is as followed. The functions include: PTZ direction control,
step, zoom, focus, iris, and setup operation, patrol between spots, trail patrol,
boundary scan, assistant switch, light switch, level rotation and so on.

Decoder A (B) line connects with XVR A (B) line. The connection is

77 right.
M Click <Main menu> <System configuration> <PTZ setup>
_ to set the PTZ parameters.

The PTZ functions are decided by the PTZ protocols.

16



PTZ Coniral

. - 't-r"'".‘- ot
S Ptz ‘Tracec
Page Switch =
i

Cancel

Figure 3.10 PTZ Setup
<Speed> Set the PTZ rotation range. Default range: 1 ~ 8.
<Zoom>  Click / button to adjust the zoom multiple of the camera.
<Focus> Click / button to adjust the focus of the camera.
<Iris> Click / button to adjust the iris of the camera.

<Direction Control> Control the PTZ rotation. 8 directions control is
supportive.(4 directions in Front panel is supportive).

<High Speed PTZ> Full-screen show channel image. Left press mouse and
control PTZ to rotate orientation. Left press mouse and
then rotate the mouse to adjust the zoom multiple of the
camera.

<Set> Enter the function operation menu.

<Page Switch> Switch between different pages.

Special functions:
1. Preset

Set a location for the preset, calls the preset points, PTZ automatically turns to
the setting position .
1) Preset option Set a location for the preset, procedure is as follows:
Stepl: in Figure 3.10, click the Direction button will turn into preset
position, click the Settings button to enter Figure 3.11.
Step 2: click the Preset button, and then write the preset points in the
input blank,
Step 3: click Settings button, return the Figure 3.10 Complete setup,
that is the preset points and preset position corresponds.

17



Clear Preset: Input preset points, click Remove button, remove the preset.

PTZ Config

Function

Tour
Pattern |

Border Del Preset

Figure 3.11 Preset Setting

2) Preset Point Calls

In Figure 3.10, click Page Shift button, enter PTZ control interface as shown in
Figure 3.12. In the input blank, write the preset points, then click Preset button,

PTZ turn to the corresponding preset point. Preset button Preset point input
blank.

PTZ Coniral

;. |
Preset
Pattern Tour

P TP T — e —
[ AutnScan [ AuinPan

“Page Switch

|
Cancel

Figure 3.12 PTZ Control

2. Cruise between Points

Multiple preset points connected cruise lines, call cruise between points, the
PTZ run around on the line.

1) Cruise Between Points Settings

18



Cruise lines are connected by multiple preset points, setting procedure is as
follows:
Stepl: In Figure 3.10, the Direction key will turn PTZ to designated
location, click Settings button to enter Figure 3.13.

Step 2: Click Cruise buttons, the write proper value into the Cruise
Line and Preset Points blank, then click Add Preset Points
button, complete setting (also can add and delete cruise line
which has been set up).

Step 3: Repeat stepl and step2, until set out all the preset designated
cruise lines.

Remove Preset: Please input preset value in the blank, click Remove Preset
button, then remove the preset points.

Remove Cruise Line: Input the number of cruise line, click Remove Cruise
Lines button, then remove the cruise lines set.

i PTZ Config

Funeticn

Preset
e — .j atrol No 1

Pattcrn Add Preset

pel Tour

Figure 3.13 Cruise Between Points Setting

2) The Calls of Cruise between Points

In Figure 3.10, click Page Shift button, enter PTZ control menu as shown in
Figure 3.12. Please input the number of cruise in the value blank, then click
Cruise between Points button, PTZ begins to work on the cruise line. Click
Stop button to stop cruise.

3. Scan

PTZ also can work on the preset scan line repeatedly.

19



1) Scan setup

Stepl: In Figure 3.10, click Setup button, enter Figure 3.14;
Step2: Click Scan button, the input proper value in the scan value blank;

Step3: Click Start button, enter Figure3.10, here you can set the following
items: Zoom/Focus/Aperture/Direction and so on. Click Setup
button to go back Figure 3.14;

Step4: Click End button to complete setup. Click the right button of the
mouse to exit.

PTZ Config

Figure 3.14 Scan Setup

2) Scan Calls

In Figure 3.10, click Page Shift button, then enter PTZ control menu as shown
in Figure 3.12. Please input the number of scan in the value blank, and then
click Scan button, PTZ begins to work on the scan line. Click Stop button to

stop.

4. Boundary Scan
1) Boundary Scan setup

Stepl: In Figure 3.10, click Direction button to turn the PTZ to preset
direction, then click Setup button enter Figure 3.15, select the
left boundary, return to Figure 3.10;

Step2: Please click direction arrows to adjust PTZ direction, click Setup
button enter Figure3.15, and then select the right boundary,
return to Figure 3.10;

Step3: Complete setup, that is the position of left and right boundary

20



FTZ Config

Function Patlern
Prcsct

Tour

Palrol No

Patlern | Leflt |
Border ] | Right |

Figure 3.15 Boundary Scan Setup

2) Boundary Scan Calls

In Figure 3.10, click Page Shift button, then enter PTZ control menu as shown
in Figure 3.12. Please input the number of scan in the value blank , then click
Scan button, PTZ begins to work on the scan line . Click Stop button to stop.

3) Horizontal Rotating

Click Horizontally Rotating button, PTZ begins to rotate horizontally (relative to
the original position of the camera) Click the Stop button to stop.

4) Rotate

Click on horizontal Rotating button, PTZ turn around.

5) Reset

Line scan button border. PTZ restart, all the data clears to O.
6) Page Shift

In Figure 3.12, click Page Shift button into Figure3.16, setting auxiliary
function. Auxiliary number corresponding to auxiliary switch on the decoder.
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PT¥ Control
Dircct Aux Qper
_I_.l_g_hl et | Open | Close |

AU Mum Qiper

1] Open | [TClose )

[Paze switeh |

[ cancel

Figure 3.16 Auxiliary Function Control

<Intuitive Auxiliary Operation> Choose auxiliary equipment, select Open or
Close button, switch control.

<Auxiliary Number> The operation of corresponding auxiliary switch
according to PTZ agreement.

<Page Shift> In Figure 3.16, click Page Shift button enter the Figure 3.17
PTZ Main Menu , the menu itself can be control by the menu
control buttons.

3.5.6 Color Setting

Set the selective image parameters (current channel for single window display
and cursor place for multi-window display) You can use the desktop shortcut
menu and enter the interface. The image parameters include: tonality,
brightness, contrast, saturation. You can set different parameters at different
time sections.

Color Setting

Hrighiness

sHLUrGiEon

Figure 3.18 Color Setting
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3.5.7 Output Adjust

Adjust TV output area parameters. You can use the desktop shortcut menu or
enter <Main Menu> <Management Tools> <Output Adjust>.

[ T outpar Adjust

Figure 3.19 Output Adjust

3.5.8 Logout

Logout shut down the system or reboot up. You can use the desktop shortcut
menu or enter <Main menu>.

c . Logout

® o

Logonl Shutdown

Figure 3.20 Logout/Shutdown/Reboot the system
<Logout> Quit the menu. Offer password next entrance.

<Shut down> Quit the system. Turn off the power supply. When press the
shutdown button, there is schedule hint. After three seconds,
the system is shut down. Cancel midway is of no effect.

<Reboot> Quit the system. Reboot up the system.

3.5.9 Window Switch

Preview in single window/four windows/eight windows/nine windows/sixteen

windows according to your choice.
23



4 Main Menu

4.1 Main Menu Navigation

Main Menu Sub Menu Function
Config Set the recording configuration, recording type,
recording time section
Record Playback Set recording look-up, recording play, video file
storage
backup Detec.t or f_ormat backup equipment, back the
selective files
_ Set motion detect alarm channel, sensitivity,
Motion area, linkage parameters: defending time
detection section, alarm output, screen hint, recording,
PTZ, patrol
Set camera mask alarm channel, sensitivity,
Video blind | linkage
parameters: defending time section, alarm
Alarm output, screen hint, recording, PTZ, patrol
Set video loss alarm channel, linkage
Video loss parameters:
defending time, section, alarm output, screen
hint, recording, PTZ, patrol
Set alarm input channel, equipment type,
Alarm input | linkage
parameters: defending time section, alarm
output, screen hint, recording, PTZ, patrol
Alarm output Set alarm mode: configuration, manual, shut
down
System General S_et syste_m time, da_ta format,_language, ha_rd
. : . . disk full time operation, machine number, video
configuration | configuration : .
format, output mode, summertime, stay time
Set main(assistant)coding parameter: code
Encode mode, resolving ability, frame rate, code stream
: . control,
configuration | . .
image quality type, code stream value, frame
between value, video/audio enable
Network Set basic network parameters, DHCP and DNS
confiquration parameters, network
g high speed download
Net Service PPPOE, NTP, Email, IP purview, DDNS

parameter
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Set channel name, preview hint icon state,

GUl display | transparency, cover area, time title, channel
time fold

PTZ Set channel, PTZ protocol, address, baud rate,

configuration | date bit, stop bit, check

Sengl port_ Set serial port function, baud rate, date bit, stop

Configuration bit. check

(RS232) ’

Tour Set patrol mode and interval time
Set appointed hard disk as read-write disc,

Hard disk read_omy

management | disc or redundant disc, clear data, resume date
and so on

User Modify user, team or password. Add user or

management | team. Delete user or team.

Management onfine user Egiikl_tgskconnecnon with the already login
the account after, break until booting up again.

tools TV adjust Adjust TV u_pside, downside, nearside,
starboard distance

Automatic Set automatic reboot system and automatic

maintenance | deleting files.

Resume setup state: common setup, code
setup,

Restore recording setup, alarm setup, network setup,
network service, preview playback, serial port,
setup, user management

Hard d|s.k Display hard disk capability and recording time

information

System Coqe _stream Display code stream information
statistics

information Log Clear all log information according to the log
information video and time

!Edltlon _ Display edition information

information

Shut down Logout, shut down or reboot
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4.2 Record

4.2.1 Record Config

Set the recording parameters in the surveillance channel. The system is set 24
hours consecutive recording in the first startup. You can enter <Main Menu>
<Recording function> <Recording setup> to set.

There is at least one read-write hard disk.(refer to chapter 4.5.1)

FfEE—,  re——— e—
Advonced r CFR F

Cancel

Figure 4.1 Record Config

<Channel> Choose the corresponding channel number to set the channel.
Choose the all option to set the entire channels.

<Redundancy> Choose the redundancy function option to implement the file
double backup function. Double backup is writing the video
files in two hard disks. When you do the double backup,
make sure that there are two hard disks installed. One is
read-write disk and the other is redundant disk. (refer to
4.5.1).

<Length> Set the time length of each video file. 60minutes is default value.

<PreRecord> Record 1-30 seconds before the action. (Time length is decided
by the code stream).

<Record mode> Set video state: schedule, manual or stop.

26



Schedule: Record according to the set video type (Common,
detection and alarm) and time section.
Manual: Click the button and the according channel is recording no
matter the channel in any state.
Stop: Click the stop button and the according channel stops
recording no matter the channel in any state.

<Period> Set the time section of common recording. The recording will start
only in the set range.

<Record type> Set recording type: regular, detection or alarm.

Regular:  Perform the regular recording in the set time section. The
video file type is “R”.
Detect: Trigger the “motion detect”, “camera mask” or “video loss”
signal. When above alarm is set as opening recording, the
“detection recording” state is on. The video file type is “M".
Alarm: Trigger the external alarm signal in the set time section.
When above alarm is set as opening recording, the
“detection recording” state is on. The video file type is “A”.

14

Refer to chapter 4.3 to set corresponding alarm function.

4.2.2 Snapshot Storage

Setup snapshot parameters for different channels. At first time it's set for
24hours snapshot continuously, plus go to <Main Menu> <Record>
<Snapshot Storage> for appropriate settings.

F_ﬂ If normal snapshot storage, plus setup Snap at <Main Menu>
<Advanced> <Snapshot> (plus refer to chapter 4.5.1 HDD
Manage).
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W Main Menu s>Record >SnapShol Slorage

p
Channel |1

S
Record. W@ Schedul
Week I'Thu
period 1 [on : oo
Perind 3 {00 1 00
Ferind 3 |00 ! 00

Perind 4 o

[TAadvinred | | Bl

Figure 4.2 SnapShot Storage
<Channel> Select the related channel to set, click "all" to set all channels.

<Presnap> Setup presnap picture quantity before recording, default is 5
pieces.

<Record> Set record status, "Schedule”, "Manual" and "Stop™:
Schedule: Realize snapshot according to record type (regular, detect and
alarm) and period.
Manual: No matter what the present channel is in a state, once choose
"manual” button, it will have snapshot at related channels.
Stop: No matter what the present channel is in a state, once choose
"stop" button, it will stop snapshot at related channels.

<Period> Set normal record period, it only startup Snapshot Storage at set
period.

<Type> Three types: Regular, detect and alarm.

<Record type> Three types: Regular, detect and alarm.
Regular:  snapshot at set period.
Detect: snapshot at set period when motion detect, video blind and
video loss which are preset for snapshot enable.
Alarm: snapshot at set period when alarm in which is preset for
shapshot enable.

&/
For related alarm function, plus refer to chapter 4.3.
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4.2.3 Playback

Refer to chapter 3.5.2.

4.2.4 Backup

You can back up the video files to external storage through setup.

@

The storage must be installed before the file backup. If the
backup is terminated, the already backup can playback
individually.

| & Main Menu->Record >Backup

2 ID Mamei Typel Remnin Tatal | |- r‘.‘-l."ll.'t"i
| El DevilISB DISK) LoD GB/A.0D GB

—
2 |E] pevilDE DVD+RW) 100 GB/1.00 GB |

Backun

[ Erise

r Stop

Cancel

Figure 4.3 Backup

<Detect> Detect the storage connected with the XVR such as hard disk or

universal disk.

<Erase> Choose the file to delete and click erasure to delete the file.

<Stop> Stop the backup.

<Backup> Click backup button and the dialog box is popped up. You can

choose the backup file according to the type, channel and time.
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Resgurired ) Remaining o KB 00 B

—rmrmrE— a————
I Start el

Figure 4.4 File Backup
<Remove> Clear the file information.
<Add> Show the file information satisfying the set file attributes.

<Start/pause> Click the play button to start the backup and click the pause
button to stop the backup.

<Cancel> During backup you can exit the page layout to carry out other
functions.

4.3 Alarm Function

Alarm functions include: motion detect, video blind, video loss, alarm input and
alarm output.

4.3.1 Motion Detect

When system detects the motion signal that reaches the set sensitivity, the
motion detect alarm is on and the linkage function is turned on.
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;: Moin Menu-=Alarm-=Molion [Deiocl

cameel

Figure 4.4 Motion Detect
<Channel> Choose the set motion detect channel.
<Enable> Means that the motion detects function is on.
<Sensitivity> Choose in the six options according to the sensitivity.
<Region > Click setup and enter the set area. The area is divided into
PAL22X18. Green block means the current cursor area. Yellow
block means the dynamic detect defensive area. Black block

means the unfenced area. You can set the area as followed, Drag
the mouse and draw the area.

Figure 4.5 Region

<Period> Trigger the motion detect signal in the set time section. You can set
according to week or set uniformly. Each day is divided into four
time sections. ‘@’ means the set valid.
31



Main Menu-=Alarm->Motion Delect-=5el
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Figure 4.6 set the time section

<Interval> Only one alarm signal is turned on even there are several motions
detect signals in the set interval.

<Alarm output> Start the external equipment of corresponding linkage alarm
when the motion detection alarm is turned on.

<Delay> Delay a few moments and stop when the alarm state is turned off.
The range is 10~300 seconds.

<Record channel> Choose the recording channel (multiple options
supportive)Trigger the video signal when the alarm is
turned on.
Set in the <recording setup> and perform the linkage recording.

Start detecting video files in the corresponding time section.

<Tour> Meaning that the selective channel is single window alternate patrol
preview. The interval is set in the <Main Menu> <System>
<Tour>.

<Snapshot> Choose record channels, when alarm happens, system triggers
related channels for snapshot signal.

Fﬂ For Snapshot activation, plus go to set period, detect and alarm

enable at <Main Menu> <Record> <Record Config>.
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<PTZ Activation>Set the PTZ activation when the alarm is turned on.

Set the patrol between spots, trail patrol and so on.

PTZ activation is set in the <Shortcut menu> <PTZ control>.

Main Menu >Alarm >Motion Detect-=PTZ Activation

CAM 1 [None E | CAM 2 |Mone
'AM 3 [None |=} o CAM 4 |Mone
CAM 5 [None Il o0 | cams [Mone

AM T N one Y | @ AM B -r-[.l'.'l_l_'lf_

CAM 2 [Mone | ] | cam 1 {Mone

CAMOLL [None it L | CAM 12 |Mone
CAM I3 [None ] | CAM 14 [MOne

AN 15 ;_H_II_IIl_:' =1 -:'_ | CAM In .T'-!!I_I_I_t'

Figure 4.8 PTZ Activation

<Delay> When alarm is over, recording will last some seconds (10~300sec),
then stop.

<Show message> Pop the alarm information dialog box in the local host
computer screen.

<Send EMAIL> Means to send an email to user when the alarm is turned on.

Set in the <Net Service> and send email.

4.3.2 Video Blind

When the video image is influenced by the environment such as bad
brightness or reaching the set sensitivity parameter, the camera mask function
is turned on and the linkage function is turned on.
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Y Main Menu->Alarm->Video Blind

Period
‘lnrm Cnntpud

ard Channel |

A vanced | ik “rancel
Figure 4.9 Video Blind

Set method: refer to chapter 4.3.1. Motion detect

“Advanced” button is the same as right click.

4.3.3 Video Loss

When the equipment cannot obtain the channel video signal, the video loss
alarm is turned on and the linkage function is turned on.

Figure 4.10 Video loss

Set method: refer to chapter 4.3.1. Motion detect



“Advanced” button is the same as right click.

4.3.4 Alarm Input

When the equipment obtains the external alarm signal, the alarm function is
turned on.

“ B Main Menu—=Afarm-=Alarm In put

Alurm In | 1 Enanble

|Marmal ¢ ™|

I‘-—";':!_‘I Py
T Intcrvial

wJarm i TR

Record Channel _.-._:1.;”

FTE Activation
Show Message 1| Send Email |

Buozeer | FTP upload | |

Advanced
Figure 4.11 Alarm Input

Set method: refer to chapter 4.3.1. Motion detect

7
"Advanced" button is the same as right click.

4.3.5 Alarm Output

Refer to chapter 3.5.4.

4.3.6 Abnormal

Analyzing and inspecting current software and hardware of the device: When
some abnormal events happen, the device will make a relative answer such
as show message and buzzer.
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“Td main Menn-=Alarm =abnormality

Event Tvpc

Enahle

Figure 4.12 Abnormal
<Event Type> selecting abnormity you want to inspect.
<Enable> Select it to make sure abnormal function workable.

<Show message> Automatically alarm cue dialog box come out of the main
screen.

<Buzzer> Device will have two long voice “beep” while alarm is happening.

4.4 System Setup

Set the system parameters such as General, Encode, Net Work, Net
Service, GUI Display, PTZ Config, RS232 and Tour Setup.

4.4.1 General

| 2 HGL

s via s ::|-r

Figure 4.13 General Setup
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<System time> Set the system data and time.

<Date format> Choose the data format: YMD, MDY, and DMY.
<Date Separator> Choose list separator of the data format.
<Time Format> Choose time format: 24-hour or 12-hour.

<Language> English. French. Portuguese, Russian, Italian, S-Chinese,
T-Chinese, Spanish, Thai, Greek, Japanese, German, Polish.

<HDD full> Choose stop record: Stop recording when the hard disk is full.
Choose overwrite: Cover the earliest recording files and continue
recording when the hard disk is full.

<DVR No. > Only when the address button in the remote controller and the
corresponding DVR number is matched, the remote operation
is valid.

<Video Standard> PAL or NTSC.

<Auto Logout> Set the latency time in 0-60. 0 means no latency time.

<DST> Choose the summer time option and pop the dialog box as followed.

Miain Meno-=Sysiem->Genernl-=57

M b

Figure 4.14 DST (Week)

Moin Menu-=System-=General-=DST

Hf Enable
() pay of week @ Date
®mo ol - ol ol

B -l -0 5] IS |

Figure 4.15 DST (Date)
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4.4.2 Encode Setup

Set the video/audio code parameter: video file, remote monitoring and so on.
Set every independent channel’s coding parameter in the left part, and set the
combine encode parameter in the right part.

(7
Combine encode introduces video compression technique
which combines and compresses multi-channel’s video to a
special channel. Applying for Multi-channel playback simultaneously,
Dial-up multi-channel real-time monitor, mobile monitor and so on.

“Fo Muin Menu-=System-~Encode

Channel
Clompression
Eesolutinn
Frame Eale{FPS
Hit Rate Type
Craality

Bit Balei Kh/S

Figure 4.16 Encode setup
<Channel> Choose the channel number.
<Compression> Standard H.264 main profile.

<Resolution> Resolution type: D1/ HD1/CIF / QCIF.
<Frame Rate> P: 1 frame/s~25 frame/s; N: 1 frame/s~30 frame/s.

<Bit Rate Type> You can choose limited code stream or variable code stream.
When you choose the variable code stream there are six
image quality options.

<Bit Rate> Set the code stream value to modify the image quality. The larger
code stream value the better image quality.
D1(1000~1500kbps) ,CIF(384~1500kbps) ,QCIF (64~512kbps).
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<Video/Audio> When the icons are all in reverse displayed, the video file is
video and audio multiplex stream. Combine Enable.

<Combine Enable> When the icons are all in reverse displayed, opening
combination coding functions.

<Mode>  Multi-channel playback is used in all channels playback
Simultaneously, and the narrowband transmission is used in

multi-channel real-time remote monitoring simultaneously at
narrowband state, especially used in mobile monitor.

4.4.3 Network Setup

"B Main Menu-=System->NetWork

| wire Metcard [T L BHCP Enuhle

Primuiry [OHS

Secondaory DHNS i

Figure 4.17 Network
<Net Card> You can choose cable network card or wireless network card.

<DHCP Enable> Obtain IP address automatically (not suggested) DHCP
server is preinstalled.

<|P address> Set the IP address. Default: 192.168.1.10.
<Subnet mask> Set the subnet mask code. Default: 255.255.255.0.
<Gateway> Set the default gateway. Default: 192.168.1.1.

<DNS setup> Domain Name Server. It translates the domain name into IP

address. The IP address is offered by network provider. The
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address must be set and reboot then it works.
<TCP port> Default: 34567.
<HTTP port> Default: 80.
<HS Download> High Speed Download.

<Transfer Policy> There are three strategies: self-adaption, image quality
precedence and fluency precedence. The code stream will
adjust according to the setup. Self-adaption is the tradeoff
between the image quality precedence and fluency
precedence. Fluency precedence and self-adaption are
valid only when the assistant code stream is turned on.
Otherwise image quality precedence is valid.

4.4.4 Net Service
Choose the network service option and click the set button to configure the

advanced network functions or double click the service button to configure the
parameters.

IFIXHS Set lnvalid
I FTPE

Belosbblc: Bl cvmntoan
LIFN>

Figure 4.18 Net Service

<PPPoOE Setup>

Input the user name and password that ISP(Internet service provider) provides.
After saving it reboot up your system. Then the XVR will build a network
connection based on PPPoE. The IP address will change into dynamic IP
address after above operation is well done.
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Main Mcocnu-=Systcm-=NctScrvice _SPPPOR

(E—

Cancel |

Figure 4.9 PPoE

Operation: After PPPoE dialing successfully look up the IP address in the
<IP address> and obtain the current IP address. Then use this IP
address to visit the XVR through user port.

<NTP setup> The NTP server must be installed in the PC.

Figure 4.20 NTP

<Host computer IP> Input the IP address installed NTP server.
<Port> Default 123. You can set the port according to NTP server.

<Time zone> London GMT+0 Berlin GMT +1 Cairo GMT +2 Moscow GMT +3
New Delhi GMT+5 Bangkok GMT +7 Hong Kong Beijing GMT
+8 Tokyo GMT +9 Sydney GMT +10 Hawaii GMT-10 Alaska
GMT-9 Pacific time GMT-8 American mountain time GMT-7
American mid time GMT-6 American eastern time GMT-5
Atlantic time GMT-4 Brazil GMT-3 Atlantic mid time GMT-2.

<Update Period> The same with the NTP server check interval. Default:
10minutes.

<EMAIL setup> If the alarm is turned on or the alarm linkage photos are taken.
Send an email about the alarm information and the photos
to appoint address.
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Main Menu-=Syuiem-=NetService-=EM AT

Yol SMTP Scrved

|adarm Message

Figure 4.21 EMAIL

<SMTP Server> Email server address. It could be an IP address or domain
name. Domain name can be translated only it is the correct
DNS configuration.

<Port> Email server port number.

<SSL> Decide whether using Secure Socket Layer protocol to login.

<User Name> Apply the email server user name.

<Password> Input the password corresponding to the user.

<Sender> Set the email sender address.

<Receiver> Send the email to appointed receivers when the alarm is turned
on. You can set three receivers at most.

<Title> You can set as you wish.

<IP Filter setup>  When choosing the white list, only the listed IP address
can connect the XVR. The 64 IP addressed are
supportive in the list. When choosing the black list, the
listed IP address cannot connect the XVR. The 64 IP
addressed are supportive in the list. You can delete the
set IP address by V in the options.

Z/
':'J When the same IP address is in the white and black list at the
same time, the black list precedence is higher.
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" Muin Menn =Syslem-=NetServioe—=1P FILTER

0 |Banned IP

Figure 4.22 IP FILTER
<DDNS> It is the abbreviation of dynamic domain name server.
<Local domain name> Provide the domain name registered by DDNS.
<User name> Provide the account registered by DDNS.
<Password> Provide the password registered by DDNS. When the DDNS is

successfully configured and start, you can connect the domain
name in the IE address column to visit.

i/
':'J The DNS setup must be configured correctly in the network
setup.

" Main Menu-=% yalem-—=MNetse rvice-=DDNS

= s =]
DDNS Type |[CN99 (]

Enable

(' —ancel
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<FTP Setup> FTP is available only when alarm happens, or alarm activates
record and snapshot, it will upload related record and napshot
pictures to FTP server.

" Main Menu-=S yetem-=MNetService =F B

Enahle |

Wser Mamce

|

|.

|

|
Password |

Figure 4.24 FTP setup
<Enable> Click Enable, then all settings will be available.
<Server IP> IP address for FTP server.
<Port> Domain Port of FTP, default 21.
<User Name> User name of FTP.
<Password> Password of user.
<Max File Length> Max length for upload files at every packed, default 128M.
<Dir. Name> Directory of uploading files.

<Wireless Config> ADSL through 3G net card, use CMS to visit and config
the device.



Main Meno-=5Systcm->NetService->Wircless Config x

]II_'l"L'lj-]lI'.l.L' |

(essassassn

P oaddress

ok [T cancel )
Figure 4.25 Wireless Config

<Enable> Choose Enable to make all settings available.

<Type> Dial type, default AUTO.

<Wireless AP> 3G access point.

<Dial Number> 3G Dial Number.

<User Name> User name of 3G.

<Password>Password of dial user.

<IP Address> IP address, got from dial.

<Mobile Monitor Setup> To visit the device by mobile, plus make a router

mapping of this port and use CMS to monitor and
operate it by protocol.

Main Menu->System->NetService->Mobil ﬁ

Enable _J

Porl

Figure 4.26 Mobile Monitor Setup

<Enable> Select it to make sure abnormal function workable.
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<Port> It's a port of mobile monitoring which you need to make a router
mapping of if want to visit it by mobile.

<UPNP> UPNP protocol can auto port forwarding on router, make sure
UPNP is running on router before use it.

Main Menu >System >NetServite sUrnp 28

Make sure UPNP is running on router,belon

using this

Cancel

Figure 4.27
<Enable> Choose Enable to make sure all UPNP settings available.

<HTTP>  Route will automatically distribute HTTP port for the device, when
IE viewing, it needs this port (e.g. 60.12.9.26:66)

<TCP> Router will automatically distribute TCP port for the device, when
monitoring via CMS, it need this port.

<Mobile Port> Router will automatically distribute Mobile Port for the device,
when mobile monitor, it need this port.

4.4.5 GUI Display

Configure the video output parameters including the front output mode and
code output mode.

Front output: In the local preview mode include: channel title, time display,
channel title, record status, alarm status, bit rate info,
transparency and region cover.

Code output: In the network surveillance and video file mode include:
channel title, time display, channel title, record status, alarm
status, bit rate info, transparency and region cover.
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" Main Menu-=System->GUT Display

Channel Title r'Tl

Time Dasplay E Channel Titl E

Record Staius H Alarm Status H
parEncy & B 55

Resalutiomn il_l_l:-‘l-‘ fOE -

Figure 4.28 GUI Display

<Channel Title> Click the channel name modify button and enter the channel
name menu. Modify the channel name. The 16 Chinese
characters and 25 letters are supportive.

<Time Display> Means the selective state. Display the system data and time
in the surveillance window.

<Channel Title> Means the selective state. Display the system channel
number in the surveillance window.

<Record Status> Means the selective state. Display the system recording
status in the surveillance window.

<Alarm Status> Means the selective state. Display the system alarm status in
the surveillance window.

<Bitrate info> Means the selective state. The ninth window displays the code
stream information in the nine-window preview status.

<Transparency> Choose the background image transparency. The range
is128~255.

<Resolution> Set display resolution.

<Channel> Choose the set code output channel number.

<Region Cover> Means the selective state. Click the cover area button and
enter the corresponding channel window. You can cover the

arbitrary using mouse. (Black region is for output)
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4.4.6 PTZ Setup

Figure 4.29 PTZ setup

<Channel> Choose the dome camera input channel.

<Protocol> Choose the corresponding dome protocol. (PELCOD as an
example)

<Address > Set as the corresponding dome address. Default: 1. The address
must be consistent with the dome address.

<Baud rate> Choose the corresponding dome baud rate length. You can
control the PTZ. Default: 115200.

<Data bits> Include 5-8 options. Default: 8.
<Stop bits> Include 2 options. Default: 1.

<Parity> Include odd check, even check, sign check, blank check. Default:
void.
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4.4.7 RS232 Setup

& Muain Menu >System >E5232

| ——

| - - [

Funciion |Console
|

Boudrnie e §]

Data Bils :i\'

S5top Hits |

I
Purity !T'JIIIH'

Figure 4.30 RS232 setup

<Serial Port Function> Common serial port is used to debug and update
program or set up specific serial port.

<Baud rate> Choose the corresponding baud rate length.
<Data bits> Include 5-8 options.
<Stop bits> Include 2 options.

<Parity> Include odd, even, mark, space.

4.4.8 Tour Setup

Set the patrol display. ‘' means that the tour mode is turned on. You can
choose the single window, four windows, nine windows; sixteen windows
patrol display or single display.
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M Main Monu->5ysiemosTou

Ak )
Enable Tour L)

i J
EEEEHTEIEREDOTET
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Egﬂ%@ﬂﬁ@!ﬂmﬂ!@@@l

Interval

Figure 4.31 tour setup

<Interval> Set the patrol switch interval. The set range is 5-120 seconds,
meaning turn off/on the patrol.

4.4.9 Digital Channel Manager

Digital channel manage includes digital channel, channel status and channel
type mode.

There is only channel type when all analog channel

ﬁﬁ mode.

w= IMain Menu-=Eystem-=Digital

| e C -

ChannelType

Set channel mode

Figure 4.32 Full Analog Channel Mode
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Oigital channels Channeal status ChannelTypea

L

= Set the number of chhanmel paramatars

|' Cancel |

Figure 4.33 Mixed Mode

(1)Digital Channels

| Enable
chronization B
Connection modea '.’-_?irrgiﬂ conng =
Metwork Configuration list

Configur, name  Davi
chContfigl

= Enable

v moda BAulti-link [~ Palling time [1¢
anfiguration list

f._.r_1r|'|:.]u-|. name  Devics T';,pu > A Remate accd

0 chCanfigid IPC 3

fAdvanced| [T OR ) ["Cancel |

Figure 4.35 Multi-channel Digital
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<Channel> Select channel title;

<Enable> Open digital channel, tick enable, then can do related settings;

<Time Synchronization> Tick it means the time of this channel and device is
the same.

<Connection Mode> can be singe connect or multi-ink, multi-link modes can
connect to several devices, device will be tour displayed one by
one, tour interval can be set, no less then 10s;

<Delete> If the user want to change device, select the existing device,
click delete will be ok.

<Add> Click add will come out below page to add new device:

Hamate access configuration =

qur. name  |chic cunfig oz
IPC *| Protoco
= [ Stream Maln Stream| =
Jevice address [192.168.1.20 TR —
Port 34587

Usarmama ladmim 1assword

Figure 4.36 Remote Access Configuration

<Configur. Name> Device is with default config title, users can revise it as
you like;

<Device Type> There are three types: IPC, DVR, HVR, the user can choose
as what you like, default is IPC;

<Protocol>  System default is TCP protocol;

<Remote Channel> Users can input remote channel title from the device that
you want to connect remotely;

<Stream> User can input remote channel title from the device that you
want to connect remotely;

<Device address> IP address of device;
<Port> Default is 34567;

<User name> Default is admin;
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Ffﬂ Click the ‘Search’ button, will show all the devices
that searched out, user can choose any of the device

that you like.

Remote act figuration

Configur. name -ch:j:gr.fiqn;jr;}

Device Typa P ~| Protocaol

Feamote aocess | Strearm

Dewvic
Paort
Usermamea

FProtocol [ONVIF ~| TEgareh | T oOR - MCEancel

Figure 4.37 Remote Channel Configuration

(2)Channel status

Channel status is to show the status of all the digital channel, including Max

Resolution, This Resolution, Connection Status.

For example: The channel status for 4+2 mode is as below:

olution Conne

P

Figure 4.38 A ‘Unknown’ Status
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[ mChannel status

Conn

Figure 4.39 All-digital Channel Status

Under all digital channel mode, Max resolution of channel 3 is D1, if it was

connected to a device with resolution over D1 ( such as 960H), you will see

below:

X

Figure 4.40 A Red "X"




(3) Channel mode

*ChanneallType

Digita Analog
1080 J20P 2604 D1 HDA CIF | 1080 J20FP 96504 D1 HD1 Cll

: 4
e ———

Maximum number of replay supported tunnel; 2

L S 1 1=

Figure 4.41 Channel Type

F{j The system support mode of 0+6, 4+2, 2+4, 0+4, 0+2 etc., user can
shift the mode as they like.

45 Advanced

4.5.1 HDD manage

Configure and manage the hard disk. The menu displays current hard disk
information: hard disk number, input port, type, status and overall capability.
The operation include: setup the write-read disk, read-only disk, redundant
disk, hard disk format, resume default. Choose the hard disk and click the right
function button to execute.

Read/Write Disk: The equipment can write or read data.

Read-only Disk: The equipment can read data but cannot write
(4
> data.
Redundant Disk: Double backup the video files in the write-read
disk.
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“® Main Mcnu-=Advanced-=HDD Manage

Read /Write

rite Mormal Smapshot

oL II.1-~|--.' o _!.I F —
Read /W l!ll.. Mormal Read only
Read /Write Mormal

Read /Write Mormal Redundani
Read/Wrile

: et
Read /Write Format Disk

Read /Wrile Mormal = RECOVET 2 ]
e

Read /Writc Mormal

Partitiom

Cancel

Figure 4.42 HDD Manage

4.5.2 Account

Manage the user purview.

(1) the character length is 8 bytes at most for the following user and user
team name. The blank ahead or behind the character string is invalid.
The middle blank in the character string is valid. Legal characters include:
letter, number, underline, subtraction sign and dot.

(2) There is no limit in the user and user group. You can add or delete the
user group according to user definition. The factory setup include:
user\admin. You can set the team as you wish. The user can appoint the
purview in the group.

(3) The user management includes: group and user. The group and user
name cannot be the same. Each user only belongs to one group.
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BE Main Menu-sAdvanced-=Account

1 JiiscrMimec 1 Poui
1 D admin admin

|:| auest UsEr

Sutus | Mlodify ser ’

(iRl . -
Hormal | Modify Group

Defaule v

] defaunte usecr

! [(madity Passwerd

[ add oecr

i 2]
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| Pelete eer
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§ Cuncel '
Figure 4.43 Account

<Modify User> Modify the existed user attribute.

<Modify Group> Modify the existed team attribute.

<Modify Password> Modify the user password. You can set 1-6 bit password.

@

<Add User>

The blank ahead or behind the char string is invalid. The
middle blank in the char string is valid.

The user who possess the user control purview can
modify his/her own or other users password

Main Mr:n|1—':ui.|:|'l.':in.':nrl—_'.:-.-xr:-.‘.nnnt—;ﬂ}'lnrﬁf:.-' Pass o8

User Hanle |admin

Confirm

Figure 4.44 Modify Password

Add a user in the team and set the user purview. Enter the
menu interface and input the user name and password. Choose
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the team and choose whether cover using the user. Cover
using means that the account can be used by multiple users at
the same time. Once choose the team the user purview is the
subclass of the team. We recommend that the common user’s
purview is lower than the advanced user.

Muin Menu->advanced = Account-=add User

ladmin

Shutdown
l—| Channel Title
D scheduale
| .l- ] Backup
El voD Management

I: E!'I/l:lllllllll
f (5 | (e LT
Figure 4.45 Add User

<Add Group> Add a user team and set the purview. There are 36 different
purviews: shut down the equipment, real time surveillance,
playback, recording setup, video file backup and so on.

| s |H 2
1Ui";;£3—"

2 El Chanpel Title

A Eement
.

P
[Frenneel |

Figure 4.46 Add Group

<Delete User> Delete the current user. Choose the user and click delete user
button.

<Delete Group> Delete the current group. Choose the group and click delete
group button.
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Main Meno-=Advanced-=accouni-=Delete Sroup ‘E

OUF |(user 2t |

ladmin

Memo  |jadministrator group

Figure 4.47 Delete Group |

4.5.3 Online User

Look up the network user information in the local DVR. You can choose the
network user and cut the connection. Then the user is locked until next
boot-strap.

s Muie Menn-sadyvanoed-=Onlise User

| Liser Mok LE*

Figure 4.48 Online User

4.5.4 TV Adjust

Refer to chapter 3.5.7.

4.5.5 Auto Maintain

The user can set the auto reboot time and auto file deleting time limit.
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@ Main Menu-=>Advanced =AuloMaintain

|Every Thursday [*] at  |DLo0

cancel

Figure 4.49 Auto maintain

4.5.6 Restore

The system restore to the default setup. You can choose the items according
to the menu.

"B Main Menu-=Advanced

The Configoration of Channel Encoding/Channel title/ Time title

Regional Coverage ' ¥ideo Color

Figure 4.50 Restore

4.5.7 Upgrade

- & Main Menu—>advanced->Upgrade

Uperade Position |USE DISK

de file hootfonthin

Tperade | cancel

Figure 4.51 Upgrade
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<Upgrade> Choose USB interface.

<Upgrade File> Choose the file which needs upgraded.

4.5.8 Device Info

Provide device interface info like audio in, alarm in/out to be conveniently used
for user.

; '.-. Moim Meno-=Advanced-=Device Info

Alarm Ot Channels (2

\General

Tnneel

Figure 4.52 Device Info.

4.6 Info

4.6.1 HDD Info

Display the hard disk state: hard disk type, overall capability, residual
capability, the recording time and so on.

M riain Menn =info

Mormal
Hormal
rrorraal
Harmal
Mol
Mormal
Maormal
Marmal

Marmal

A Tt q'r:;nn:hng rmes | Cancel

Figure 4.53 HDD Info
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Clue: ‘o’ means that the hard disk is normal. ‘X’ means that the hard disk is
broken-down. ‘- means that there is no hard disk. If the user needs to
change the damaged hard disk, you must shut down the XVR and take
up all the damaged hard disks, then install a new one. Behind serial
number means the current working disk such as ‘1*. If the
corresponding disk is damaged, the information will show “?”.

4.6.2 BPS

Display the code stream(Kb/S) and hard disk capability (MB/H) in real time. It
displays as the wave sketch map.

[ ol Main Mean-=Info--BPS

hannwol

Figure 4.54 BPS

4.6.3LOG

Look up system log according to the set mode. Log information include:
system operation, configuration operation, data management, alarm affair,
recording operation, user management, and file management and so on. Set
the time section to look up and click the look up button. The log information will
display as a list. (One page is 128 items) Press Page up or Page down button
to look up and press delete button to clear all the log information.
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O riain Menn

e
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Figure 4.55 LOG

4.6.4 Version

Display the basic information such as hardware information, software edition,
and issue data and so on.

" Main Mene=Info->Version

Record Channel 16

Extra Channel @

Alarm In )

alarm Output

Syslem I F 200, T

Build Date 2000-07-31 113449

Slatis 44

Figure 4.56 Version

4.7 Shut down System

Refer to chapter 3.5.8.
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5 CMS Software Operation

The Central Management Software (CMS) is a powerful and professional
centralized monitoring system designed for all range of applications and
projects. With CMS, accessing and monitoring multiple surveillance
equipment such as XVRs, and Mega-Pixel IP cameras is just a few clicks
away. The feature-packed intelligent surveillance offers the professional users
with complete and enhanced surveillance experiences.

w @
P D.nr'nn- Analog Dama IP Camara
; S

Video Server

BHC Cable

“Neiwork -

-----------------------------------------------

FEATURES

User and authority management
Support N level organization management, user management and
authority setup management.

Data interface technology

All data exchanged use data interface technology, so it can support kinds
of database very Flexibility, such as SQL, MYSQL, XML data and so on.

Support adding device by EXCEL

The platform supports the user adopts Excel to add and edit devices. It's
very convenience for user to maintain quantities of devices, improving
system's usability and greatly reducing lots of maintenance work.

Intelligent video transport protocol
Intelligent video transport protocol can maximize the using of network
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bandwidth. Especially on the condition of Front-end network bandwidth
limited, based on the system assures the high quality Image, even in the
low network bandwidth, it can work well.

Scalable and distributed network architecture

Supporting multi servers to run coordinately, and load balancing intelligent.
It is flexibility to add server and enhance the system capacity on the
condition of assuring the integrity of the system.

Perfect video monitoring

While running real time monitoring, the system can support alarm,
recording, auto monitoring record, playback and so on. It can exactly
control the recording status of every channel.

Dynamic regulation decoding buffer
It is flexibility to adjust the fluency/real-time of video images in real-time
monitoring, which can meet different users’ demands.

Central management

Centralized management of data throughout the system and the function of
data forwarding provide the perfect multi-user real-time monitoring
program. Remote users can real-time monitor, record and playback
through network.

Easy operation
In access control, users can easily control and set all monitor points
through the system. It also integrates E-map function.

High integration level
The system integrates other related functions, like Alarm, Voice, etc.

High reliability
The system designs a special fault tolerance measures to assure data
Integrity and the system to run dependability.

Good scalability
The system designs for Service, has a good scalability and adaptability to
maximally protect user investment.

Support Network management and load balancing

Support multi devices volume upgrade via network

Support user DIY interface and multi languages

Support 4 channels real-time playback

Support connecting multi devices and viewing many videos
(Real-time monitoring and playback)

65



5.1 Installation Instruction

(1) Find "CMS_ChnEng_V1.0.0.6.T.20090315.Exe" in the CD and run it like
below figure.

(S8 TS Setun

BN Vil

Welcome
)— Welcone to the instsller for CAS
k‘ Ii'is :trm:}ly recommendsd that souw esxit all

Yindews prograns bafore comtinming with this
S .f‘;-:" inztallation

IE won have any siher prograns ooming plesse
elick Eqm:e]._. clasze the ProOSy ans, and rm bhas
sebup wmain

Otherwiza, click Hect to continoe.

(2) Click "Next”, then go the below figure.

"='-Iu M5 Setlp

Uxer InFormation

Enter yomr ncor tofornetion and clicl Hemti to conticme

| cgaek || Mwery [ Conest |

(3) Click "Browser" to select setup path (default path "C:\Program Files"), then
click "Next" to select Start Menu folder like below figure.
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T | Mb Srhip

Imxtxllatian Folder L

L "
Fhere would pouw Lile CMS to bo instelled? I .,:-"

The software will be instelled in the Eolder listed below. To selact o
diffsrant loesiinn, sither Egps tm 3 new pakh, or click Changs o broves for
an existing Eolder.

In=txall CAS kot

C:hProgram PFilashCHS Change. .

Spacs regquirsd; 12,1 AB
Gpace awailable on selected drive: 19 83 GB

[gmeee | e | [ geea |

(4) Click "Next" to start setup and end setup like below figure.

Installation Succesasful
The CAS  inztmllaiion 1x complsts.

Thark: yaa Esr chaoxang CMEI

Flezs=me click Fimaxh {a s=xid Lhis= anztsllesr.

(5)Click "Finish" to end the setup, at the time it will come up this icon in the

desktop .Plus follow Chapter 3,4,5 instructions to operate this software
after finish installation.

5.2 Introduction of Basic Functions

(a)Run it, default user name: super, no password.
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(b)Choose<System> <Device Manage>, see below figure.

SRERE

uuuuu

(c) Add Device, see below figure.

5.z} [ P aadress | Paet | MaC |
1P Sasrch I Add Devcn | SrErhiEA

Dinrar Tdmeres- ]-E‘S-:

LaginTyoe k= Addrans ™ oammn 1" Senslm

Lipsr Fare |G=|"'-r| Pessiyod
o =
vanaar | R |
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<Login Type> IP address, domain name, and serial ID.

Add IP address: IP search and manually add IP address.
IP search: Click “IP search” and select the XVR IP address to add device.

Manually add IP address: Fill with IP address, TCP port, user name, and

password, then you can click <add device>to
add device.

(d)Double click the device name, then choose main stream or extra stream,
see below picture.
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Device display area

In this area, you can preview live screens by device and do super account
administrator setting. You can click device name or channel group to
change channel.

Operation area

You can preview live screens, also can click right key to do system
configuration and video searching in this area.

Time
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Display the current time.

Video disk status area

It can display the free disk spaces which are used to store video files.

PTZ

Control and operate the PTZ.

Operation log
It will record every operation action information when you operate the
system.

Menu Area

Users could set single menu and sub-menu in this area, and select relevant
menus to operate video surveillance system in the control center.

Diagram Menu Configuration

No.

First
Menu

Second
Menu

Third
Menu

Function & Instruction

Operating
right

Preview

Click preview button
"Monitor" to choose a
preview of the screen,
touring & switching among
all channels and snapshot
pictures of the screen.
Shut down/open preview
menu

Admin/User

PTZ

Controlling the speed
cameras to go up, down,
left, right and stop by
operating panel, adjusting
speed, zoom, focus, iris
and auto pan, presetting
and touring.

Admin/User

Color

Set brightness ,contrast,
saturation and hue for
video screen

Admin/User

System

Device
manager

Add
zone

Add zone for all devices

Admin/User

Add
device

Add video surveillance
devices

Admin/User
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10

11

Modify

Modify device name, IP
address, user name and
password

Admin/User

Delete

Delete video surveillance
devices

Admin/User

Local
Config

Base
config

Select disk, disk list and
logs maintenance

Admin/User

Alarm
setting

Enable audio activated by
alarm

Admin/User

Account

Group

Add and delete users'
operating rights

Admin

User

Add, delete and manage
users:

Set user name, password
and operating rights of
menu

Admin

Local
Log

Search alarm log and
operation log in set time
area.

Admin/User

12

13

Record

Playback

Search record file and
playback

Admin/User

Record
Plan

Set record time for every
day

Admin/User

14

15

Advance

Decoder

Set XVR and decoder

Admin/User

Map

Using this map, it can
visually show every
cameras location and find
current monitoring page
directly

Admin/User

5.2.1 Preview

Diagram Functions and instructions of preview

No. | Button Meanings

1 click it to preview full screen for every channel
2 click it to preview 4 screens

3 click it to preview 9 screens
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No. | Button Meanings

4 click it to preview 16 screens

5 click it to preview 25 screens

6 click it to preview 36 screens

7 click to preview 64 screens

7 click it to enter full screen interface

5.2.2 Right-click Menu

At operating area, user can do below operation by right-click:

Window: 2

Close window
Close =11 window
Aadio

Lﬂtﬂl recurd
Zoomad

Snapshot

Start talk
Device config
Color Setiing
View Full

<Close window> Close the current screen.

<Close all window> Close all the current screens.
<Audio> Click it and hear the voices from preset screens.

<Local record> Click it to record at current channel and save the record to the
relevant disk.

<Zoomed> Select it to realize enlarge the part of screen you select.
<Start talk> Start to connect the audio to realize talk.

<Snapshot> Capture pictures from current channel at any time and save it to
relevant disk.
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<Device Config> Click it and go to device configuration interface.
<Color Setting> Adjust the color of the current screen.

<View Full> See the current screen full screen.

5.2.3 PTZ Control

When speed cameras are connected with XVR, user can control it at this
center, turn up, down, left and right, stop running, adjust turning speed, zoom,
focus and iris, preset and tour configuration. When users enable touring
function, the speed cameras will tour according to preset.

Button Function

means "turn”, means "stop turning"

Drag this pole to adjust speed rate

Click tozoomin, Click to zoom out

Click tofocusin, Click to focus out

Click toirisin, Click toiris out

Click to start PTZ, Click  to stop PTZ

Set a location for the preset, calls the preset points, PTZ
automatically turns to the setting position. You can add,
delete and configure preset point

Multiple preset points connected to tour lines. If you call
touring between points, the PTZ will run around on the
line

5.2.4 Color Setting

Button Function

Brightness
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Button Function

Contrast

Saturation

Hue

Click " I=falt | to resume initial values.

5.2.5 System

Device manager, here to manage the device.

(a) Click ' to add zone, see below figure. to add a zone

(e)Click ¥ to add device, see below figure.

<Device Name> Device name.

<Domain> Domain name by external network such as xxxx.3322.org,
xxxx.dyndns.org, Xxxxx.oray.org etc..

<|P Address> IP address.
<Port> TCP port.
<User Name> User name.

<Password> User password.
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Click "OK" after you have done above parameters, see the Figure, you could
dggble click to open this device. Choose only one of Domain name and IP
address.

Double click the device name, the sub menu will display, as below figure. You
can double click to choose one or more channel to display.
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(c) Click # to modify device, see below Figure. After finishing all the
modifications, click "OK".
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(d) Delete device: Choose the devices which you want to delete, then

click T Please make sure the device is disconnected before modifying and
deleting it.

L2
(e) Click = toimport a device configuration that you export before.

A _ : :
() Click " to export the current device configuration.
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(g) Click ™ to test if the current network is ok.
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5.3 Local Config

5.3.1 Base Config
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<Log Maintence> The days of alarm and operation log keep.
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<Picture DIR> The directory of location picture storage.
<Snapshot Format> The format of snapshot, you can choose BMP or JPG.
<Record DIR> The directory of location record storage.

<Sync time with PC> Adjusting device and PC in order to make both at the
same time.

<Language> Choose language of CMS.

5.3.2 Alarm Setting

s Lty A Sy | jacerime | g 0nim | femnnh
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<Device List> Choose one device to set alarm parameter.

<Alarm Enable> Click it to make sure all alarm functions available.

<Alarm Prompt Sound> Select any alarm prompt sound which you like.

Open sound file path: Browse and choose prompt
sound.

<Auto Watch Warn> Choose it to add following channels by alarm activated.
Please go to choose alarm type first.

5.3.3 Record Plan

You can set your record plan for every channel. You also can choose a record
template for every day.
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<Overwrite> Click it, and then it will cover the old records when HDD is full.
<Length> The length of the time of one record file.

<Alarm Record Delay> The system will record ten seconds after the alarm

stopping.
<Disk List>C, D, E, F.
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Edit Template, see right figure. After setting name, you can set one day record
periods as you like, then click "Add" and "OK".

Choose "channel" first, then go to set record time from Monday to Sunday.
After set record plan, If it need to record, please make sure the below three
points.

(1) Choose a disk for recording at Local config.

(2) make sure the device is connected to network.

(3) Make sure local computer is always open.

5.3.4 DDNS Config

To analyze server via dynamic domain name, you can configure the DDNS.
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T

|

<Server IP> The domain name that analyze server.

<Port> The default value is 15000.

When the DDNS is successfully configured and start, you can use the domain
name in the IE address column to visit.

5.3.5 Version Info
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<Version Info> CMS's version. (Build Date, video, net, decoder, device config,
Net, Playback)

5.4 Remote Config

Select a device first, then set its configurations, see below figure.
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The function of this part you can refer to chapter Main Menu guideline.

5.4.1 Account

(1) Group
You can add & delete user group, also can set user group permission, see
below figure.
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(2) User
You can add user, delete user and modify user password, also can select a
group for user, see below figure.
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5.4.2 Local Log

You could search menu operation log, and alarm log by time, see right figure.
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The operation log includes.

Log Type |G|:eratiun

EA S LA

Oiperation |.|!|II

Al

Yidzo
Playvhack
Talk
Backup

Tyne Date  |Lser Manager
Map

Client Canfig
Cevice Config

The alarm log includes:

Log Type Harm |

Alarm al R

LI Trioger
Yideo Mation
Yideo Loss
Yidea Bind

Type | Date [Pk Error

Dk Ful

You also can export the log message to local PC.
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5.4.3 Record Playback

There are two playback modes, including Remote playback and Local
playback.

£ ko -l ] £4 ] ]
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<Remote playback> Playback at Device-side.

<Local playback> Playback at Client-side.
User could playback record files of any times, max playback channel is four.

Button Function

Play

Pause

Stop

Slow play

Fast play

Last frame

Next frame

5.4.4 Download & Backup

You can playback record files at the time and channels you select. Click
"Download/Backup" and select "Browse" to choose a directory to save record
files.
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5.4.5 E-MAP

E-MAP is a plan for simulating live screen, user can use it to add & delete
cameras and set e-map alarm activation, see below figure.

(1) Click "Edit" first at the left bottom, then click "Picture Edit", see below

figure.
[TERISERE X
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(2)Click "Add" to add picture, see below figure.

(3) After set picture name, description, picture path, then click "OK" and back
to main interface. Click "Picture" and drag one picture to the right side, see

right figure.
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(4) Click "Device" to drag device's channel to the map, then the channel name
will appear at the map, double-click it to name and describe it.

Tour : Video touring makes the different channels in turn displays in a display
box. All the channels in Management software can be displayed.

(a) Click the icon ., you will enter into right interface, selecting "Add" to go to

next step.

(b) Click the "Add" button, you can develop a touring scheme, also can delete
and change the scheme.
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(c) In the software operating area, select a window, and then click the right
mouse button, choosing tour project and selecting one in this menu, you can
achieve video touring operations.

Window: 1

l:lcr:- w L nﬂuw
Clo=z« all window
foadi o

Lacal yecord
Eoomsd

Emapzhot

SEtart talls
Dewace coanfig
Color Svl-i.t'l:n.g_
View Full

Tour Froject L4

MY 4 0w

Task Config

Task configuration can be set up to connect the extra video stream. You can

do volume settings to the video channel, according to the actual needs of
different scenarios.

LA

(a) Click the icon T , you will enter into right interface, selecting "Add" to go

to next step.
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k
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(b) Click the "Add" button, you can develop a task scheme, also can delete
and change the scheme.
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(b) In the CMS area at the left side of the device tree, you can select task
configuration, as right figure

Device
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6 FAQ and Maintenance

6.1 FAQ

If the problems are not listed, please contact the local service or call the HQ
service. We are willing to offer the service.

(1) The XVR cannot boot up normally.
Possible reasons are as followed:
1 The power supply is not correct.
2 Switch power supply line is not in good connection.
3 Switch power supply is damaged.
4 The program updating is wrong.
5 The hard disk is damaged or the hard disk lines are broken.
6 The front panel is damaged.
7 The main board of the XVR is damaged.

(2) The XVR reboots automatically or stops working after boot up a few
minutes.
Possible reasons are as followed:
1 The input voltage is not stable or too low.
2 The hard disk is damaged or the hard disk lines are broken.
3 The power of the switch power supply is low.
4 Frontal video signal is not stable.
5 Bad heat radiator or too much dust or bad running circumstance for
the XVR.
6 The hardware of the XVR is damaged.

(3) System cannot detect hard disk.
Possible reasons are as followed:
1 The hard disk power supply line is not connected.
2 The cables of the hard disk are damaged.
3 The hard disk is damaged.
4 The SATA port of main board is damaged.

(4) There is no video outputs in single channel, multiple channels and all
channels.
Possible reasons are as followed:
1 The program is not matched. Please update the program.
2 The image brightness is all 0. Please restore the default setup.
3 There is no video input signal or the signal is too weak.
4 The channel protection or the screen protection is set.
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5 The hardware of the XVR is damaged.

(5) Real-time image problems such as the image color or the brightness
distortion.
Possible reasons are as followed:
1 When using the BNC output, the option between the N mode or PAL
mode is wrong and the image becomes black and white.
2 The XVR is not matched the monitor impedance.
3 The video transmission distance is too far or the loss of the video
transmission line is too large.
4 The color and brightness setting of the XVR is wrong.

(6) I cannot find the video files in local playback mode.
Possible reasons are as followed:
1 The data line of the hard disk is damaged.
2 The hard disk is damaged.
3 Update the different program with the origin program files.
4 The video files to look up are covered.
5 The recording is not on.

(7) The local video is not clear.
Possible reasons are as followed:
1 The image quality is too bad.
2 The reading program is wrong. Reboot up the XVR.
3 The data line of the hard disk is damaged.
4 The hard disk is damaged.
5 The hardware of the XVR is damaged.

(8) There is no audio signal in the surveillance window.
Possible reasons are as followed:
1 It is not an active tone arm.
2 It is not an active sound box.
3 The audio lines are damaged.
4 The hardware of the XVR is damaged.

(9) There is audio signal in the surveillance window but mo audio signal in the
playback state.
Possible reasons are as followed:
1 Setting issues: the audio option is not chosen.
2 The according channel is not connected with the video.

(10) The time is wrong.
Possible reasons are as followed:
1 Setting is wrong..

2 The battery is in bad connection or the voltage is too low.
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3 The oscillation is damaged.

(11) The XVR cannot control the PTZ.
Possible reasons are as followed:

1 There is something wrong with the frontal PTZ.

2 The setting, connection or the installation of the PTZ decoder is not
correct.

3 The connections are not correct.

4 The PTZ setting of the XVR is not correct.

5 The protocols of the PTZ decoder and the XVR are not matched.

6 The address of the PTZ decoder and the XVR are not matched.

7 When multiple decoders are connected, the far port of the PTZ
decoder line A (B) must connect a 120 Q resistance to reduce the
reflection otherwise the PTZ control is not stable.

8 The distance is too far.

(12) The motion detect is not working,
Possible reasons are as followed:
1 The time range set is not correct.
2 The motion detect area set is not correct.
3 The sensitivity is too low.
4 Limited by some hardware edition.

(13) I cannot login via web or CMS.
Possible reasons are as followed:

1 The system is windows 98 or wins me. We recommend updating to
windows 2000sp4 or higher Version or installing the software for low
edition.

2 ActiveX is hold back.

3 The version is not exceeded dx8.1. Update the display card driver.

4 Network connection failure.

5 Network setting issues.

6 Invalid password or user name.

7 The CMS is not matched the XVR program version.

(14) The image is not clear or there is no image in network preview state or
video file playback state.
Possible reasons are as followed:
1 Network is not stable.
2 The user machine is resource limited.
3 Choose the play-in-team mode in the network setup of XVR.
4 The region shelter or channel protection is set.
5 The user has no surveillance purview.
6 The real-time image of the hard disk recording machine itself is not

clear.
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(15) Network connection is not stable.
Possible reasons are as followed:
1 Network is not stable.
2 IP address is conflicted.
3 MAC address is conflicted.
4 The net card of the XVR is bad.

(16) There is something wrong with the USB backup or writing a CD.
Possible reasons are as followed:
1 The rewritable machine and the hard disk are shared the same data
lines.
2 The data is too much. Please stop recording and backup.
3 The data exceeds the backup storage.
4 The backup equipment is not compatible.
5 The backup equipment is damaged.

(17) The keyboard cannot control the XVR.
Possible reasons are as followed:
1 The serial port of the XVR is not set correctly.
2 The address is not correct.
3 When multiple transformers are connected, the power supply is not
large enough. Please give each transformer individual power supply.
4 The distance is too far.

(18) Alarm cannot be recessional.
Possible reasons are as followed:
1 The setting of the alarm is not correct.
2 The alarm output is turned on manually.
3 The input machine is damaged or the connections are not correct.
4 There are some problems for specific program edition, Please update
the program.

(19) Alarm is not working.
Possible reasons are as followed:
1 The setting of the alarm is not correct.
2 The connection of the alarm is not correct.
3 The alarm input signal is not correct.
4 A alarm is connected with two loops synchronously.

(20) The remote controller is not working,
Possible reasons are as followed:
1 The remote control address is not correct.
2 The remote control distance is too far or the angle is too large.

3 The battery is used up.
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4 The remote controller or the front panel of the recording machine is
damaged.

(21) The storage time is not enough.
Possible reasons are as followed:
1 Front vision quality is bad. The lens is too dirty. The vision is in
backlighting installation.
2 The hard disk capability is not enough.
3 The hard disk is damaged.

(22) The downloading files cannot play.
Possible reasons are as followed:
1 There is no media player.
2 There is no DX8.1 software or higher edition.
3 There is no DivX503Bundle.exe file to play AVI video files.
4 The DivX503Bundle.exe and ffdshow-2004 1012 .exe files must be
installed in the windows xp system.

(23) | cannot remember the advanced code or network code in the local menu
operation.

Please contact the local service or call the HQ service. We will offer the
service according the machine type and the program edition.

(24) Q: under win7 system, IE control can not be automatically download and
installation

Possible reasons are as followed:

1 Manual install IE plug-in, not as administrator identity installation, lead to
installation does not completely or invalid. The right mouse button click
need to install the control, and then select installation as an administrator

2 Automatic download control of time is intercept system; Can the
computer on the following operation: "start" run "input" msconfig and
then select "tools" change the UAC Settings "set for "never notice"

3 Control is antivirus software intercept, when installation can shut off the
anti-virus software, and then install, after the success of the installation
to put us set to trust the control software.

(25) Q: under win7 system, CMS installation failure, or after installation,
cannot open CMS software control is antivirus software intercept, when
installation can shut off the anti-virus software, and then install, after the
success of the installation to put us set to trust the control software.
Possible reasons are as followed:

1 Not as administrator identity installation, lead to installation does not
completely or invalid.

92



6.2 Maintenance

(1) Please brush printed circuit boards, connectors, fans, machine box and so
on regularly.

(2) Please keep the grounding well done to prevent the video or audio signal
interfered and the XVR from static or inductive electricity.

(3) Do not pull out the video signal line or RS-232 port or RS-485 port with the
power on.

(4) Do not use the TV in the local video output port (VOUT) of XVR. It will
damage the video output circuit easily.

(5) Do not turn off the switch directly. Please use the turn-off function in the
menu or press the turn-off button in the panel (3 seconds or longer) to
protect the hard disk.

(6) Please keep the XVR away from heat resource.

(7)Please keep the XVR ventilated for better heat radiator. Please check the
system and maintain regularly.
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